  

	Ass #
	Chapter.
	ASSIGNMENT CMPS 386 Intro to Data Mining - Spring 22
	Due
	Points

	Q – quiz

P – project

A – assign.

L - lab
	Quiz - Q
Proj - P
	Note:   

Please provide the program assignment documentation according to the Syllabus.doc and 1_Project_Submittals.doc
 in the Guidelines directory at http://classes.jgspectrum.com/classes/386_S22/Guidelines/. 
Your Assignment.doc is posted at http://classes.jgspectrum.com/classes/386_S22/Assignment.doc/. 
1. CMPS 386 supports Windows 10 operating system. 
Mac user: If you run Mac it is your responsibility to install and run Windows on Mac. You may select one of two options. You can either use Mac Boot Camp, a native feature of the macOS operating system - https://macpaw.com/how-to/install-windows-on-mac. or you can use a third party virtualization program e.g. VirtualBox for free - https://www.youtube.com/watch?v=IvLm_PZJDz0 – 25 min. Both methods have their own pros and cons -  https://macpaw.com/how-to/install-windows-on-mac.
Recommendation for Mac user: First you need to install VirtualBox for free and then install window10 on your VirtualBox. Please follow the video at

https://www.youtube.com/watch?v=IvLm_PZJDz0 – 25 min.

In order to install Window 10 you need to have  just windows 10 file or the .iso windows 10 image file. You can buy it electronically at our store https://www.bkstr.com/lavernestore/shop./software. 

As a computer science student you can get access to https://e5.onthehub.com/WebStore/Security/Signin.aspx?ws=7d4d2e17-e59b-e011-969d-0030487d8897&vsro=8&rurl=%2fWebStore%2fProductsByMajorVersionList.aspx%3fws%3d7d4d2e17-e59b-e011-969d-0030487d8897%26vsro%3d8%26JSEnabled%3d1 and download different software for free.

You need to ask for the password our executive secretary Stephanie Pruett spruett@laverne.edu. You can visit her in Mainiero Hall 152.
2. Friendly remainder: You have to read a chapter in the textbook. Execute exercises in section of the current chapter with the extension .ipynb using jupyter lab mode.

1. After each class meeting understand and run exercises of Self Check for each chapter section. Each time after we finish a chapter review the Wrap-Up  section.
2. Notepad++ Editor. Use Notepad++ (or Dreamweaver if you have) to all next HOPs and projects. Download Notepad++ from https://notepad-plus-plus.org/downloads/ by clicking the latest release button, then DOWNLOAD button for 32 bit x86. While you get the file on your computer click it on follow the instructions. You can download from my class website as well. 

3. Activate all extensions for all files in order to see all extensions (such as .html, .css) in your windows directories (it applies to all windows operating systems): 

· Select the search icon (next to your Start button at the left bottom of your window) => type Control Panel => File Explorer Options =>View tab => under settings section: “Files and Folder”

· Uncheck “Don’t show hidden files, folders, or drives”, 

· Uncheck “Hide extension for known file types”,

· Check “Show hidden files, folders and drives”.

4. Detail view for each file and directory of each folder (it applies to all windows operating systems):

First select any directory from Explorer=>select right panel of the directories and files but right click outside of any directories and files =>view=>details

5. Your project file name and a file should be named as follows:

ch#+P# or L#+ S22+AssignmentTitle+yourLastName.docx For example: 

ch3+P1+S22+ Body_Mass_Calculator+yourLastName.docx
6. https://www.youtube.com/watch?v=M7ioWqUX99o&t=1s – how to use slides
7. To determine which directory the notebook is open use

pwd

8. To determine the python PATH type to the search field next to the Start button 

cmd
next type

py -0p

9. IDLE is a simple cross-platform IDE for running and editing Python programs that is included free with Python and is released under the open-source Python Software Foundation License. To get IDLE:
In the “Type here to search” field at the bottom of your screen type 

Anaconda Powershell Prompt

Idle

Now you can open file and run any Python program.
10. Visual Studio Code (VSC): Download and install Visual Studio Code from Microsoft https://code.visualstudio.com/download. The Python extension will automatically install the Pylance (IntellSense) and Jupyter extensions to give you the best experience when working with Python files and Jupyter notebooks. 

Follow the following instructions which I copied from VSCode:

· Step 1. Install a supported version of Python on your system (note: that the system install of Python on macOS is not supported).

· Step 2. Install the Python extension for Visual Studio Code (you may see a prompt window to install it)

· Step 3. Open or create a Python file and start coding!
    Notice: some libraries are not supported.

11. 4/2022: During installation Community Edition of Visual Studio 2019 or 2022 at https://visualstudio.microsoft.com/vs/community/ select all defaults (including Add Workloads) and you may select all components including Python.

In case of VS 2022 if you cannot see the start icon for VS 2022 you can find under C:\Program Files\Microsoft Visual Studio\2022\Community\Common7\IDE => click deven.exe. You can copy shortcuts to your desktop, not a file!
NOTE: Good link to Python projects in Visual Studio is https://docs.microsoft.com/en-us/visualstudio/python/managing-python-projects-in-visual-studio?view=vs-2022
	
	

	L1
	Ch0
	1. Download and install Anaconda Python distribution at https://www.anaconda.com/products/individual p.xlvi of the textbook. Select option Just for me. Anaconda includes Python 3.8, the IPython interpreter and local Jupyter Notebooks server which allows users to combine text, graphics, audio, video and interactive coding functionality, in a web browser for interactive programming exercises and self-checks. Pre-installed with Anaconda Individual Edition. Follow the links here for documentation on each package.

a. Requests
b. BeautifulSoup
c. SQL Alchemy
d. NumPy
e. Pandas
f. Scikit-Learn
g. Matplotlib
2. In the “Type here to search” field at the bottom of your screen type 

Anaconda Prompt

select “Run as Administrator on the right, select Anaconda Prompt.
3. Execute step by step the following commands to update the conda package manager we will use:

conda update conda

conda update --all

4. Install the Prospector Static Code Analysis Tool from the command-line window

pip install prospector

5. Test: Interactive Mode
at the command-line window type
ipython
and evaluate expression:

In [1]: 45 + 72
Out[1]: 117

In [2]: 5 * (12.7 – 4) / 2

Out[2]: 21.75

In [3] run proj1.py

<Ctrl> + d to exit and press Enter

6. Test: Interpreter Mode
Download RollDieDynamic.py to your desktop from my class website at http://classes.jgspectrum.com/classes/372_F21/examples/ch01/.  Use the Edge browser. Right click on  RollDieDynamic.py and select “Save target as”. Then select “Desktop”.

At the command-line window type (replace jozefg by your directory name below)

cd C:\Users\jozefg\Desktop

ipython RollDieDynamic.py 1000 1 

To stop display add an input() call at the end of the program using for example Notepad++.  The program will update the frequency die roll for the chart 1000 times for 1 die at a time.

8. Launch JupyterLab or ipyton interpreter from a given chapter’s example folder

       Open notebooks from that folder or any of its subfolder by downloading ch02.zip by:
a. Open ch02.zip

b. Move ch02 to your desktop

c. At the command-line window type (replace jozefg by your directory name below)

cd C:\Users\jozefg\Desktop\ch02

NOW you can run file.jpynb

jupyter lab
Open any notebook with extensions .ipynb by double clicking

9. To close JupyterLab

a. Close its browser and type in Anaconda Prompt

<Ctrl> + c

	2/2
	10

	L2
	Ch1


	1. Review basic Python code from CMPS 372 (Ch2, Ch3, ch4 and Ch9 using the Titanic Disaster Dataset of CMPS 372).

2. Run and interpret all Python programs in Jupyter lab for ch1 of the textbook.

	2/9
	10

	Home 
	Ch2 Ch3 of CMPS 372
	Execute self check sections in snippets_jpynb of  ch02.zip and ch03.zip of CMPS 372 class at http://classes.jgspectrum.com/classes/372_F21/LectureNotes/. Use jupyter lab mode to run all exercises.  Also I copied those files into http://classes.jgspectrum.com/classes/386_S22/examples/Code_from_CMPS372/ for your convenience.

Find the sum, product, the largest and the smallest integers of four integers in jupyter lab mode. Be prepared to show me your solution on your computer.
	2/9
	

	Quiz1
	Ch1Q1
	Study chapter 1 and Lecture Notes for Ch1 in order to be prepared for Quiz ch1.

	2/9
	15

	AsCh1
	Ch1
	A. Reminder: Our class meetings are scheduled online to the end of the semester.

B. Study and learn chapter 2 p.44 – 59. Run related Python code in Jupyter. 
C. Hands-on: Data Mining and Analytics with Weka p.31-41: 
Please place screenshots of Figures 1.28 – 1.39 in the word document named HOch1-WEKA.docx, total 12 screens using description 1 – 12 below (the textbook). Copy items below as the corresponding header before each screenshot.

Post the HOch1.docx on OneDrive to the link I have emailed you automatically on 2/9/2022 after 10 pm.
1. Download and install WEKA. Weka is a collection of machine learning algorithms for data mining tasks. Weka contains tools for data pre-processing, classification, regression, clustering, association rules, and visualization.
https://cs.waikato.ac.nz/ml/weka (or http://old-www.cms.waikato.ac.nz/ml/weka/ ) => Download => Windows => Click here to download a self-extracting executable for 64-bit Windows that includes Azul's 64-bit OpenJDK Java VM 17 (weka-3-8-6-azul-zulu-windows.exe; 133.2 MB).
Visualizing Data p.33:
3. Run Weka => Explorer => Open file… => find Seattle.csv on your computer, see Fig. 1.28 p.33 => Edit, see Fig. 1.29 p.34
4. Click Visualize tab, see Fig. 1.30 p.34

5. Within the chart locate and click the price vs sqft-living chart, see Fig. 1.31p.35
Identifying Prediction Variables p.33:
6. Go back to 3 => click “Select attributes” => Start, see Fig. 1.32 p.36 displaying the most influential variables affecting price.
7. Preprocess => Open file… =>Iris.data.csv => Cluster=> Choose button => SimpleKMeans => click on the SimpleKMeans box =>appears the dialog box SimpleKMeans Fig. 1.33 p.37
Clustering Data p.35:
8. Within the dialog box numCluster field, type 3 and choose OK, then within the Cluster tab click Start, see Fig. 1.34 p.38.

9. Within the Results list, in the left panel right-click on the results and select Visual Cluster Assignments => displays a colored chart, see Fig. 1.35 p.38.
Classifying Data p.36:

10. Weka Explorer: Using the Iris.data.csv click on Classify => Choose => select Trees => Random Forest algorithm, see Fig. 1.36 p.39.
11. Within the Test Options field => select 66% of the data set for training, the rest for testing => Start; see Confusion Matrix the correct categorized with a 96% accuracy; see Fig. 1.37 p.39.
Data Association p.40:

12. Weka Explorer: Preprocess => DiapersAndBeer.csv => columns in data are attributes => see   the frequency of particular In the chart 
13. Associate => Start; see Fig. 1.39 p.41. 
	2/16
	15

	L3
	Ch2
	1. Run and interpret all Python programs in Jupyter lab for ch2 of the textbook.
2. Google Colab is a Jupyter Notebook implementation that provides an interactive running code and expierence.document  - I have just showed:
FROM: https://www.tutorialspoint.com/google_colab/your_first_colab_notebook.htm 

Note − As Colab implicitly uses Google Drive for storing your notebooks, ensure that you are logged in to your Google Drive account before proceeding further.

Step 1 − Open the following URL in your browser − https://colab.research.google.com. Your browser would display the following screen (assuming that you are logged into your Google Drive) −

Step 2 − Click on the NEW PYTHON 3 NOTEBOOK link at the bottom of the screen. A new notebook would open up as shown in the screen below.

.
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As you might have noticed, the notebook interface is quite similar to the one provided in Jupyter. There is a code window in which you would enter your Python code.

Setting Notebook Name

By default, the notebook uses the naming convention UntitledXX.ipynb. To rename the notebook, click on this name and type in the desired name in the edit box as shown here −
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As you might have noticed, the notebook interface is quite similar to the one provided in Jupyter. There is a code window in which you would enter your Python code.

We will call this notebook as MyFirstColabNotebook. So type in this name in the edit box and hit ENTER. The notebook will acquire the name that you have given now.

Entering Code

You will now enter a trivial Python code in the code window and execute it.

Enter the following two Python statements in the code window −

import time

print(time.ctime())

Executing Code

To execute the code, click on the arrow on the left side of the code window.
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After a while, you will see the output underneath the code window, as shown here −

Thu Feb 17 01:54:06 2022
Adding Code Cells

To add more code to your notebook, select the following menu options −

Insert / Code Cell

Alternatively, just hover the mouse at the bottom center of the Code cell. When the CODE and TEXT buttons appear, click on the CODE to add a new cell. This is shown in the screenshot below −
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A new code cell will be added underneath the current cell. Add the following two statements in the newly created code window −

time.sleep(5)

print (time.ctime())

Now, if you run this cell, you will see the following output −

Thu Feb 17 01:57:34 2022

Certainly, the time difference between the two time strings is not 5 seconds. This is obvious as you did take some time to insert the new code. Colab allows you to run all code inside your notebook without an interruption.

Run All

To run the entire code in your notebook without an interruption, execute the following menu options –

Runtime => Run all

It will give you the output as shown below −
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Note that the time difference between the two outputs is now exactly 5 seconds.

The above action can also be initiated by executing the following two menu options –

Runtime => Restart runtime

or

Runtime => Restart all runtimes

Study the different menu options under the Runtime menu to get yourself acquainted with the various options available to you for executing the notebook.
Changing Cell Order

When your notebook contains a large number of code cells, you may come across situations where you would like to change the order of execution of these cells. You can do so by selecting the cell that you want to move and clicking the UP CELL or DOWN CELL buttons shown in the following screenshot −
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You may click the buttons multiple times to move the cell for more than a single position.

Deleting Cell

During the development of your project, you may have introduced a few now-unwanted cells in your notebook. You can remove such cells from your project easily with a single click. Click on the vertical-dotted icon at the top right corner of your code cell.
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Click on the Delete cell option and the current cell will be deleted.

Now, as you have learned how to run a trivial notebook, let us explore the other capabilities of Colab.

-----------------------------------------------------------------------------------------------------

To share the notebook that you have created with other co-developers, you may share the copy that you have made in your Google Drive.

To publish the notebook to general audience, you may share it from your GitHub repository.

There is one more way to share your work and that is by clicking on the SHARE link at the top right hand corner of your Colab notebook. This will open the share box as shown here −

[image: image9.png]I3 @ nipsicon research googlecomdrveNEFW- .+ © 1 neoe =

Share with others.

Poosle





You may enter the email IDs of people with whom you would like to share the current document. You can set the kind of access by selecting from the three options shown in the above screen.

Click on the Get shareable link option to get the URL of your notebook. You will find options for whom to share as follows −

· Specified group of people

· Colleagues in your organization

· Anyone with the link

· All public on the web

Now. you know how to create/execute/save/share a notebook. In the Code cell, we used Python so far. The code cell can also be used for invoking system commands. This is explained next.

How to install libraries

https://www.tutorialspoint.com/google_colab/google_colab_installing_libraries.htm 
	2/16
	10

	Quiz2
	Ch2Q2
	Study and learn chapter 2 and Lecture Notes for Ch2 in order to be prepared for Quiz ch2.

Study chapter 3 – it will not be on the Quiz.
	2/23
	15

	L4 
	Ch3
	Hands-on p.96-98: Creating Entity Relationship Diagrams (ERD) using Lucidchart: 

Post your ERD graph as HOch2-ERD_graph.docx on OneDrive under L4 directory.


	2/23
	10

	Quiz3
	Ch3Q3
	Study and learn chapter 3 and Lecture Notes for Ch3 in order to be prepared for Quiz ch3.

Study chapter 4 p.102 - 130 – it will not be on the Quiz.
	3/2
	15

	L5
	
	2. Use a Google Chart tool at https://developers.google.com/chart/interactive/docs. 

3. Go https://developers.google.com/chart/interactive/docs/quick_start and understand the comments for the pie chart.
4. Run https://developers.google.com/chart/interactive/docs/gallery/combochart and change three values in the code and run it.

5. Add my code to the above item in order to run bar and pie charts simultaneously for the same data set – see my code slide 15 of the Lecture Notes.

6. Run  https://developers.google.com/chart/interactive/docs/gallery/areachart and change three values in the code and run it.

7. Diff Chart: Copy and run code on p.124. – not done
8. Donut: Copy https

 HYPERLINK "https://developers.google.com/chart/interactive/docs/gallery/piechart" ://developers.google.com/chart/interactive/docs/gallery/piechart#

 HYPERLINK "https://developers.google.com/chart/interactive/docs/gallery/piechart" donut  and run it

9. Gauge Chart: Copy and run code on p.139, slide 51. – not done

10. Calendar Chart: Copy and run code on p.140, slide 52. – not done

11. Candlestick Chart: Copy and run code on p.141, slide 53. – not done
	3/2
	10

	AssCh4
	Ch4Q4
	1. Study and learn chapter 4 and Lecture Notes for Ch4 in order to be prepared for Quiz ch4. 
2. Hands-on p.150-156: Data Visualization Using Tableau. Goal: is to get you up and running Tableau. Download the Tableau tool from tableau.com for free, install, follow all instructions and run Tableau Desktop tool. Post your all Figures 4.68 – 4.78 with captions and short step description between each screen as HOch4_Tableau.docx on OneDrive. Save and post the last Figure as well.
3. Note: 

a. On p. 152 I noticed if you download the “Sales by Region” file (SalesByRegion.xlsx) from the text catalog the content of the file is not correct. I created the correct file and I put into “Python_code + Data.zip” available from my class website.

b. On p.156: right click on each sheet to add to the dashboard. 

c. Notice that some functionality can be found at top bar menu e.g. New Data Source, Dashboard.
	3/9
	15 + 10

	L6
	Ch5
	Practice all features with Excel on p.159-196 using Auto-MPG.csv, Auto-MPG_cut_set.csv and SalesData.csv.
	3/9
	10

	AssCh5
	Ch5
	1. Study and learn chapter 5 and Lecture Notes for Ch5 in order to be prepared for Quiz ch5. 
2. Hands-on p.196-208: Data Analysis Using Excel. Goal: is to perform what-if processing, forecasting, and pivot table operation within Excel. All needed files are posted in Python_code + DATA.zip or use browser edge to get them from https://info.jblearning.com/jams_data_links => ch5 (you will know the file names). Post your all Figures 5.47 – 5.65 with captions as HOch5_Excel.docx on OneDrive. Save and post the last Figure as well.
	3/16
	15 + 10

	L7
	Ch6
	1. Install MySQL Workbench Interface (v. 8.0.28 done on 3/16/2022): Follow instruction on p.215, go to www.mysql.com  => DOWNLOADS => MySQL Community (GPL) Downloads => MySQL Installer for Windows => Windows (x86, 32-bit), MSI Installer (mysql-installer-web-community-8.0.28.0.msi). Create Oracle account, then download, install it and run it. If you asked for the upgrade click yes. Use the default for the installation. 
Note: After installation you will get a screen “Type and Networking” – you may try to change Port: 3306 to 3307 if you run phpMyAdmin (in CMPS 320) to avoid a port conflict. Changing the port causes the problem with “Use Strong Password Encryption for Authentication (Recommended)” on Authentication Method screen doesn’t accept your Root Account Password.  So, stay for all defaults.
2. After completion you will get the MySQL command line interface and the MySQL Workbench Interface. Close all and restart them from the Start menu.
3. Place SQL statement from chapter06.txt in order to create many tables in MySQL server.
4. Practice all features with SQL queries starting from p.222-252 using MySQL. 
	3/16
	15

	Midterm
	Ch 1 - 6
	See Guide_Midterm.doc at http://classes.jgspectrum.com/classes/386_S22/Guidelines/!!! 
	3/23
	25%

	L8
	Ch6
	Practice all features with SQL queries starting from p.252 – 278 using MySQL Workbench Interface, specifically run all SQL statements form p.252 – 262 and 269 -275.
	4/06
	10

	AssCh6
	Ch6
	1. Study and learn chapter 6 and Lecture Notes for Ch6 in order to be prepared for Quiz ch6. 
2. Hands-on p.279-286: Building a Data Quality Dashboard Using Microsoft Power BI – a business intelligence (BI) visualization tool. Goal: is create dashboards and reports from different data source types (db systems, spreadsheets, files, and more). Download and install a trial version of Power BI from https://powerbi.microsoft.com/en-us/ => scroll down => click “Download free” for Download Power BI Desktop. All needed files are posted in Python_code + DATA.zip. Post your all Figures B to L p. 280 - 286 with captions as HOch6_PowerBI.docx on OneDrive. Save the last Figure L and post as a source file as well.
	4/13
	15 + 10

	L9
	Ch7
	Review https://medium.com/swlh/get-up-and-running-with-mongodb-in-under-5-minutes-abc8770b1ef8.

1. NoSQL Database: Download and install MongoDB Community Server at https://www.mongodb.com/try/download/community. Follow all instructions, select the Complete option and select the local server. Using your File Explorer go to your installation directory C:\Program Files\MongoDB\Server\5.0\bin and click mongo.exe. Type help to see available commands. Type at the prompt

· show databases (slide 15 of ch7 Lecture Notes)
· follow Copying and Pasting the Queries of slide 18
· type db.Employees.find() to display all the documents (records) within the Employees collection.
	4/13
	10

	AssCh7
	Ch7
	1. Study and learn chapter 6 and Lecture Notes for Ch7 in order to be prepared for Quiz ch7. 
2. Hands-on p.335 - 340: Hands-on: MongoDB Managed Service and 
MongoDB Charts. Goal: is create dashboards and reports from MongoDB data source.
All needed files are posted in Python_code + DATA.zip. Post your all Figures 7.69 to 7.72 p. 336 - 340 with captions as HOch7_MongoDB.docx on OneDrive. Save the last Figure 7.72 and post as a source file as well. 

a. You may follow my steps:
b. Login into https://www.mongodb.com/atlas/database => Cluster0 => Collections => +Create Database => type MyBusiness for Database name and Sales for Collection name => Create. 
c. Select MyBusiness from the db list => CREATE COLLECTION (green button). Use atlas.txt from chapter 7 posted on my class website. Open atlas.txt in Notepad and copy each field with values separately without ids into dedication field.

d. Repeat steps to get 2 collections “SalesByCategory” and “Sales” for the MyBusiness database.
Now create charts:
e. Select MyBusiness database from the left panel 

       See FIGURE 7.68 on p.338

f. Select menu Charts => Data Sources => Next => OK => Add Data Source => Select Cluster0 => Next => select MyBusiness => Finish => OK => Next +> OK
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g. Select Dashboards from the left panel => My Dashboard => Add the chart to Dashboard => OK => Choose a Data Source (green) => MyBusiness.SalesByCategory => Next => Next
h. Continue on page 339 from Click on your project.
3. Hands-on p.327 Extra: Hands-on: NoSQL Database CouchDB. Download and install it. 
4. To install on Windows go https://couchdb.apache.org/#download  => CouchDB 3.2.1 => Windows (x64) => follow instructions:
a. Get the latest Windows binaries from the CouchDB web site
b. Follow the installation wizard steps. Accept all defaults. Type account name: admin and enter any password. Remember it.
c. Open up Fauxton from Start => Apache CouchDB => Apache CouchDB => Fauxton. It is equivalent to run http://localhost:5984/_utils/.
5. To install on Mac go https://couchdb.apache.org/#download  => CouchDB 3.2.1 => macOS (10.10+) => follow similar instructions above for Windows installation.
6. Using chapter07.txt take 4 records of Student database and create a Student Database in Fauxton (click the 1st menu item Databases => Create Database).
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7. Click Student database link. It will show submenus. Create 3 different queries. You may use my examples below but they need to be different (you may search Google) except the 1st one.
select all records:

{

   "selector": {}

}

{

   "selector": {

      "Year": "F",

      "Phone": "555-1212"

   }

}
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8. Post a student database in Fauxton and 3 different queries with separate results as HOch7_Fauxton_Extra.docx on OneDrive under AssCh7 directory. 
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10

for item 3-8

two much for extra

	L10
See L10B – installation of packages
below
	Ch8A
	1. Install Python from python.org => Downloads => select Python 3.10.4 (the latest one) => Windows Installer (64 bit) (recommended) (macOS 64-bit universal2 installer for macOS).
2. Click  IDLE (Python 3.10) program or Python 3.10 from the Start button to run the Python Interpreter.
3. Use IDLE to run program interactively or run from a file from p. 348 – 376. 
4. Exercise: Displaying a Multidimensional Array for 4 rows but the last row has values -50, -60, -70 – see slide 23
	4/20
	10

	Ass
	
	Read and learn chapter 8 – Python and R programming. Run examples in IDLE for Python from the textbook.
	4/27
	

	L11
	Ch8B
	1. To get started, download and install the R from website located at https://www.r-project.org/) => click download => ttps://mirror.las.iastate.edu/CRAN/ => Download R for Windows (or Download R for macOS  and continue) => click base => Download R-4.2.0 for Windows (79 megabytes, 64 bit).

2. Download and install RStudio-2022.02.2-485 from https://www.rstudio.com/products/rstudio/download/#download. 
	4/27
	10

	AssCh8
	Ch8
	1. Study and learn chapter 8 and Lecture Notes for Ch8 in order to be prepared for Quiz ch8. Run examples in IDLE for Python examples and run R examples in RStudio and R command line window. 
2. Hands-on p.399-406: Install Visual Studio (VS) Community Edition 2019 or 2022. 
Goal: is to create a Python script and retrieve Python templates scripts and run them; VS provides build-in templates you can use to quickly create apps that perform clustering, classification and regression. Post your all Figures 8.23, 8.24 – 8.29 p. 399 - 406 with captions as HOch8_VisualStudio.docx on OneDrive. Save the last Figure 8.30 and post as a source file as well.
Hints:
During installation Community Edition of Visual Studio 2019 or 2022 at https://visualstudio.microsoft.com/vs/community/ select all defaults (including Add Workloads) and you may select all components including Python.

In case of VS 2022 if you cannot see the start icon for VS 2022 you can find under C:\Program Files\Microsoft Visual Studio\2022\Community\Common7\IDE => click deven.exe. You can copy shortcuts to your desktop, not a file!

Open VS 2022 => continue without code
1A. View => open Cookiecuter Explore  and get FIGURE 8.25 (later you will get the content of remaining panels)
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search for python-classifier-cookiecutter => Click Next button => Create and Open Project  => In the Solution Explorer, you can see classifier project => right click classfier.py => Start without Debugging => save in the default directory( in my case was under C:\Users\jozefg\source\repos\python-sklearn-classifier-cookiecutter\classifier.sln) and I got FIGURE 8.26 image:
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# Uncomment this call when using matplotlib to generate images
# rather than displaying interactive UI.
#import matplotlib Build Action Compile
#matplotlib.use('Agg') Publish True

B Misc
from pandas import read_table File Name classifier.py
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Show output from: | General | = | = = | 55’-"

DEBUG helpers.py: is_likely_binary: False

DEBUG helpers.py: detected_encoding: {'encoding': 'ascii', 'confidence': 1.6, 'language': ''}

DEBUG helpers.py: failure: decodable_as_unicode: False

DEBUG generate.py: Writing C:\Users\jozefg\AppData\lLocal\Temp\9b5ff603-8995-460f-a2a5-284af25a2659\regression\regression.pyproj
DEBUG hooks.py: hooks_dir is hooks

{"cookiecutter": {"_output_folder_path": "C:\\Users\\jozefg\\source\\repos\\python-sklearn-regression-cookiecutter3”, "app_name":

Build Action
Successfully created files using template 'python-sklearn-regression-cookiecutter' into 'C:\Users\jozefg\source\repos\pythc N .
GitHub  Issues  Wiki How the file relates to the build and deployment

S process

Cookiecutter template for testing Python scikit-
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1B: According to the textbook you need to remove the code and replace by the code on p. 403 and receive FIGURE 8.28 (similar we got in our class session)

Repeat step 1A for python-sklearn-regression-cookiecutter p.405 => received a screenshot of it:
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Repeat step 1A for for python-sklearn-clustering-cookiecutter p.406 => reports a problem (no FIGURE 8.30) 
NOTE 1: Good link to Python projects in Visual Studio is https://docs.microsoft.com/en-us/visualstudio/python/managing-python-projects-in-visual-studio?view=vs-2022.
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	L12
	Ch8

Ch9
	1. Run snippets of Ch8B Lecture Notes slides 33, 34, 36, 37, 38, 40 or 41, 45,  47, 50 or 51.

2. Practice all SQL queries in Lecture Notes chapter 9 slide by slide (refer to slide number) using MySQL Workbench Interface. 

If you were absent you need to provide screenshots of all running queries and programs.
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	AssCh9
	
	1. Study and learn chapter 9 and Lecture Notes for Ch9 in order to be prepared for Quiz ch9
2. Hands-on p.439-443: Install OpenRefine developed by Google => https://openrefine.org/ => Downloads => Select the latest stable release 3.5+ => Windows kit with embedded Java=> download => Unzip on Desktop => open the folder => openrefine.exe  => choose file from popup browser window =>  Messy.xlsx file (available in our Python_code +Data) => Next.
Goal: is to clean up the data. Post your all Figures A – G with captions as HOch9_OpenRefine.docx on OneDrive. Moreover, add Figure H similar to Figure F after your data cleanse you have completed and post your new Messy.xlsx as well. – added after grading.
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	L13
	Ch9

Ch10
	1. Run all programs/snippets in Lecture Notes chapter 9 slides 35, 36, 37, 38, 39, 40 
2. Run snippets of Ch10 Lecture Notes slides 10, 13, 14, 15, 16, 17, 21, 22, 23, 25, 27, 28, 29, 30, 31.
If you were absent you need to provide screenshots of all running snippets/programs.
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	Ass
Ch10
	
	1. Study and learn chapter 10 and Lecture Notes for Ch10 in order to be prepared for Quiz ch10.
2. Hands-on p.473-483: Install Sover (known XLMiner. Goal: use HandsOn.xlsx file to perform clustering algorithms. Post your all Figures 10.18 – 10.30 with captions as HOch10_Solver.docx on OneDrive. Save the last Figure 10.23-1024 and 10.30 and post as a source file as well.
Steps:
https://www.solver.com/ =>Analyst Tools => Product Overview =>

https://www.solver.com/ => login => create account
https://www.solver.com/welcome-students 
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	FINAL
	Ch 7 - 11
	See Guide_Final.doc at http://classes.jgspectrum.com/classes/386_S22/Guidelines/!!! 
Make sure that all tools we have used in the second part of the semester, except Solver work for you. Email the info to me which a tool you have a problem by weekend! 
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	L10 B

Installation packages
	
	Installation packages traces info: 

I. For Python using Command line window (Start => type cmd)

II. For Jupyter in the Anaconda Prompt Shell.

I. For Python using Command line window (Start => type cmd) :

https://www.youtube.com/watch?v=M7DO94X2Cq0 – install matplotlib on Python 3.10.1 Windows 10. Commands entered are in yellow below.

Enter cmd at “Type here to search” at the bottom left corner then

C:\Users\jozefg>py
Python 3.10.4 (tags/v3.10.4:9d38120, Mar 23 2022, 23:13:41) [MSC v.1929 64 bit (AMD64)] on win32

Type "help", "copyright", "credits" or "license" for more information.

>>> pip install matplotlib
  File "<stdin>", line 1

    pip install matplotlib

        ^^^^^^^

SyntaxError: invalid syntax

>>> quit
Use quit() or Ctrl-Z plus Return to exit

>>> ^Z
C:\Users\jozefg>py -m pip --version
pip 22.0.4 from C:\Users\jozefg\AppData\Local\Programs\Python\Python310\lib\site-packages\pip (python 3.10)

You may run pip directly from the python location at C:\Users\jozefg\AppData\Local\Programs\Python\Python310\Scripts 

or

C:\Users\jozefg>py -m pip install matplotlib
Collecting matplotlib

  Downloading matplotlib-3.5.1-cp310-cp310-win_amd64.whl (7.2 MB)

     ---------------------------------------- 7.2/7.2 MB 2.0 MB/s eta 0:00:00

Collecting packaging>=20.0

  Downloading packaging-21.3-py3-none-any.whl (40 kB)

     ---------------------------------------- 40.8/40.8 KB 1.9 MB/s eta 0:00:00

Collecting pyparsing>=2.2.1

  Downloading pyparsing-3.0.8-py3-none-any.whl (98 kB)

     ---------------------------------------- 98.5/98.5 KB 2.8 MB/s eta 0:00:00

Collecting pillow>=6.2.0

  Downloading Pillow-9.1.0-cp310-cp310-win_amd64.whl (3.3 MB)

     ---------------------------------------- 3.3/3.3 MB 1.3 MB/s eta 0:00:00

Requirement already satisfied: python-dateutil>=2.7 in c:\users\jozefg\appdata\local\programs\python\python310\lib\site-packages (from matplotlib) (2.8.2)

Collecting kiwisolver>=1.0.1

  Downloading kiwisolver-1.4.2-cp310-cp310-win_amd64.whl (55 kB)

     ---------------------------------------- 55.3/55.3 KB 1.4 MB/s eta 0:00:00

Requirement already satisfied: numpy>=1.17 in c:\users\jozefg\appdata\local\programs\python\python310\lib\site-packages (from matplotlib) (1.22.3)

Collecting cycler>=0.10

  Downloading cycler-0.11.0-py3-none-any.whl (6.4 kB)

Collecting fonttools>=4.22.0

  Downloading fonttools-4.33.2-py3-none-any.whl (930 kB)

     ---------------------------------------- 930.7/930.7 KB 2.0 MB/s eta 0:00:00

Requirement already satisfied: six>=1.5 in c:\users\jozefg\appdata\local\programs\python\python310\lib\site-packages (from python-dateutil>=2.7->matplotlib) (1.16.0)

Installing collected packages: pyparsing, pillow, kiwisolver, fonttools, cycler, packaging, matplotlib

  WARNING: The scripts fonttools.exe, pyftmerge.exe, pyftsubset.exe and ttx.exe are installed in 'C:\Users\jozefg\AppData\Local\Programs\Python\Python310\Scripts' which is not on PATH.

  Consider adding this directory to PATH or, if you prefer to suppress this warning, use --no-warn-script-location.

Successfully installed cycler-0.11.0 fonttools-4.33.2 kiwisolver-1.4.2 matplotlib-3.5.1 packaging-21.3 pillow-9.1.0 pyparsing-3.0.8
C:\Users\jozefg>py -m pip install plotly
Collecting plotly

  Using cached plotly-5.7.0-py2.py3-none-any.whl (28.8 MB)

Requirement already satisfied: six in c:\users\jozefg\appdata\local\programs\python\python310\lib\site-packages (from plotly) (1.16.0)

Collecting tenacity>=6.2.0

  Using cached tenacity-8.0.1-py3-none-any.whl (24 kB)

Installing collected packages: tenacity, plotly

Successfully installed plotly-5.7.0 tenacity-8.0.1
C:\Users\jozefg>py -m pip install chart-studio
Collecting chart-studio

  Downloading chart_studio-1.1.0-py3-none-any.whl (64 kB)

     ---------------------------------------- 64.4/64.4 KB 1.2 MB/s eta 0:00:00

Requirement already satisfied: plotly in c:\users\jozefg\appdata\local\programs\python\python310\lib\site-packages (from chart-studio) (5.7.0)

Collecting requests

  Downloading requests-2.27.1-py2.py3-none-any.whl (63 kB)

     ---------------------------------------- 63.1/63.1 KB ? eta 0:00:00

Collecting retrying>=1.3.3

  Downloading retrying-1.3.3.tar.gz (10 kB)

  Preparing metadata (setup.py) ... done

Requirement already satisfied: six in c:\users\jozefg\appdata\local\programs\python\python310\lib\site-packages (from chart-studio) (1.16.0)

Requirement already satisfied: tenacity>=6.2.0 in c:\users\jozefg\appdata\local\programs\python\python310\lib\site-packages (from plotly->chart-studio) (8.0.1)

Collecting urllib3<1.27,>=1.21.1

  Downloading urllib3-1.26.9-py2.py3-none-any.whl (138 kB)

     ---------------------------------------- 139.0/139.0 KB 4.2 MB/s eta 0:00:00

Collecting certifi>=2017.4.17

  Downloading certifi-2021.10.8-py2.py3-none-any.whl (149 kB)

     ---------------------------------------- 149.2/149.2 KB 8.7 MB/s eta 0:00:00

Collecting idna<4,>=2.5

  Downloading idna-3.3-py3-none-any.whl (61 kB)

     ---------------------------------------- 61.2/61.2 KB 3.2 MB/s eta 0:00:00

Collecting charset-normalizer~=2.0.0

  Downloading charset_normalizer-2.0.12-py3-none-any.whl (39 kB)

Using legacy 'setup.py install' for retrying, since package 'wheel' is not installed.

Installing collected packages: certifi, urllib3, retrying, idna, charset-normalizer, requests, chart-studio

  Running setup.py install for retrying ... done

  WARNING: The script normalizer.exe is installed in 'C:\Users\jozefg\AppData\Local\Programs\Python\Python310\Scripts' which is not on PATH.

  Consider adding this directory to PATH or, if you prefer to suppress this warning, use --no-warn-script-location.
Successfully installed certifi-2021.10.8 charset-normalizer-2.0.12 chart-studio-1.1.0 idna-3.3 requests-2.27.1 retrying-1.3.3 urllib3-1.26.9
C:\Users\jozefg>py -m pip install sklearn
Collecting sklearn

  Downloading sklearn-0.0.tar.gz (1.1 kB)

  Preparing metadata (setup.py) ... done

Collecting scikit-learn

  Downloading scikit_learn-1.0.2-cp310-cp310-win_amd64.whl (7.2 MB)

     ---------------------------------------- 7.2/7.2 MB 4.9 MB/s eta 0:00:00

Collecting joblib>=0.11

  Downloading joblib-1.1.0-py2.py3-none-any.whl (306 kB)

     ---------------------------------------- 307.0/307.0 KB 6.3 MB/s eta 0:00:00

Collecting threadpoolctl>=2.0.0

  Downloading threadpoolctl-3.1.0-py3-none-any.whl (14 kB)

Collecting scipy>=1.1.0

  Downloading scipy-1.8.0-cp310-cp310-win_amd64.whl (37.0 MB)

     ---------------------------------------- 37.0/37.0 MB 5.7 MB/s eta 0:00:00

Requirement already satisfied: numpy>=1.14.6 in c:\users\jozefg\appdata\local\programs\python\python310\lib\site-packages (from scikit-learn->sklearn) (1.22.3)

Using legacy 'setup.py install' for sklearn, since package 'wheel' is not installed.

Installing collected packages: threadpoolctl, scipy, joblib, scikit-learn, sklearn

  Running setup.py install for sklearn ... done
Successfully installed joblib-1.1.0 scikit-learn-1.0.2 scipy-1.8.0 sklearn-0.0 threadpoolctl-3.1.0

	
	

	
	
	II. For Jupyter in Anaconda Prompt Shell:

(base) PS C:\Users\jozefg> conda list

Give you an alphabetical list

WARNING conda.gateways.disk.delete:unlink_or_rename_to_trash(144): Could not remove or rename C:\ProgramData\Anaconda3\conda-meta\astroid-2.3.1-py37_0.json.  Please remove this file manually (you may need to reboot to free file handles)

WARNING conda.gateways.disk.delete:unlink_or_rename_to_trash(144): Could not remove or rename C:\ProgramData\Anaconda3\conda-meta\pyflakes-2.1.1-py37_0.json.  Please remove this file manually (you may need to reboot to free file handles)

WARNING conda.gateways.disk.delete:unlink_or_rename_to_trash(144): Could not remove or rename C:\ProgramData\Anaconda3\conda-meta\pycodestyle-2.5.0-py37_0.json.  Please remove this file manually (you may need to reboot to free file handles)

WARNING conda.gateways.disk.delete:unlink_or_rename_to_trash(144): Could not remove or rename C:\ProgramData\Anaconda3\conda-meta\pylint-2.4.2-py37_0.json.  Please remove this file manually (you may need to reboot to free file handles)

# packages in environment at C:\ProgramData\Anaconda3:

#

# Name                    Version                   Build  Channel

_ipyw_jlab_nb_ext_conf    0.1.0                    py37_0

alabaster                 0.7.12                   py37_0

anaconda                  2019.10                  py37_0
anaconda-client           1.7.2                    py37_0

anaconda-navigator        2.0.4                    py37_0

anaconda-project          0.8.3                      py_0

asn1crypto                1.0.1                    py37_0

astroid                   2.4.1                    pypi_0    pypi

astropy                   3.2.1            py37he774522_0

atomicwrites              1.3.0                    py37_1

attrs                     19.2.0                     py_0

babel                     2.7.0                      py_0

backcall                  0.1.0                    py37_0

backports                 1.0                        py_2

backports.functools_lru_cache 1.6.4              pyhd3eb1b0_0

backports.os              0.1.1                    py37_0

backports.shutil_get_terminal_size 1.0.0                    py37_2

backports.tempfile        1.0                pyhd3eb1b0_1

backports.weakref         1.0.post1                  py_1

beautifulsoup4            4.8.0                    py37_0

bitarray                  1.0.1            py37he774522_0

bkcharts                  0.2                      py37_0

blas                      1.0                         mkl

bleach                    3.1.0                    py37_0

blosc                     1.16.3               h7bd577a_0

bokeh                     1.3.4                    py37_0

boto                      2.49.0                   py37_0

bottleneck                1.2.1            py37h452e1ab_1

bzip2                     1.0.8                he774522_0

ca-certificates           2019.8.28                     0

certifi                   2019.9.11                py37_0

cffi                      1.12.3           py37h7a1dbc1_0

chardet                   3.0.4                 py37_1003

click                     7.0                      py37_0

cloudpickle               1.2.2                      py_0

clyent                    1.2.2                    py37_1

colorama                  0.4.1                    py37_0

comtypes                  1.1.7                    py37_0

conda                     4.10.3           py37haa95532_0

conda-build               3.21.4           py37haa95532_0

conda-content-trust       0.1.1              pyhd3eb1b0_0

conda-env                 2.6.0                         1

conda-package-handling    1.7.3            py37h8cc25b3_1

conda-repo-cli            1.0.4              pyhd3eb1b0_0

conda-token               0.3.0              pyhd3eb1b0_0

conda-verify              3.4.2                      py_1

console_shortcut          0.1.1                         3

contextlib2               0.6.0                      py_0

cryptography              2.7              py37h7a1dbc1_0

curl                      7.65.3               h2a8f88b_0

cycler                    0.10.0                   py37_0

cython                    0.29.13          py37ha925a31_0

cytoolz                   0.10.0           py37he774522_0

dask                      2.5.2                      py_0

dask-core                 2.5.2                      py_0

decorator                 4.4.0                    py37_1

defusedxml                0.6.0                      py_0

distributed               2.5.2                      py_0

docutils                  0.15.2                   py37_0

dodgy                     0.2.1                    pypi_0    pypi

entrypoints               0.3                      py37_0

et_xmlfile                1.0.1                    py37_0

fastcache                 1.1.0            py37he774522_0

filelock                  3.0.12                     py_0

flake8                    3.9.2                    pypi_0    pypi

flake8-polyfill           1.0.2                    pypi_0    pypi

flask                     1.1.1                      py_0

freetype                  2.9.1                ha9979f8_1

fsspec                    0.5.2                      py_0

future                    0.18.2                   py37_1

get_terminal_size         1.0.0                h38e98db_0

gevent                    1.4.0            py37he774522_0

glob2                     0.7                        py_0

greenlet                  0.4.15           py37hfa6e2cd_0

h5py                      2.9.0            py37h5e291fa_0

hdf5                      1.10.4               h7ebc959_0

heapdict                  1.0.1                      py_0

html5lib                  1.0.1                    py37_0

icc_rt                    2019.0.0             h0cc432a_1

icu                       58.2                 ha66f8fd_1

idna                      2.8                      py37_0

imageio                   2.6.0                    py37_0

imagesize                 1.1.0                    py37_0

importlib_metadata        0.23                     py37_0

intel-openmp              2019.4                      245

ipykernel                 5.1.2            py37h39e3cac_0

ipython                   7.8.0            py37h39e3cac_0

ipython_genutils          0.2.0                    py37_0

ipywidgets                7.5.1                      py_0

isort                     4.3.21                   py37_0

itsdangerous              1.1.0                    py37_0

jdcal                     1.4.1                      py_0

jedi                      0.15.1                   py37_0

jinja2                    2.10.3                     py_0

joblib                    0.13.2                   py37_0

jpeg                      9b                   hb83a4c4_2

json5                     0.8.5                      py_0

jsonschema                3.0.2                    py37_0

jupyter                   1.0.0                    py37_7

jupyter_client            5.3.3                    py37_1

jupyter_console           6.0.0                    py37_0

jupyter_core              4.5.0                      py_0

jupyterlab                1.1.4              pyhf63ae98_0

jupyterlab_server         1.0.6                      py_0
keyring                   18.0.0                   py37_0

kiwisolver                1.1.0            py37ha925a31_0

krb5                      1.16.1               hc04afaa_7

lazy-object-proxy         1.4.2            py37he774522_0

libarchive                3.3.3                h0643e63_5

libcurl                   7.65.3               h2a8f88b_0

libiconv                  1.15                 h1df5818_7

liblief                   0.9.0                ha925a31_2

libpng                    1.6.37               h2a8f88b_0

libsodium                 1.0.16               h9d3ae62_0

libssh2                   1.8.2                h7a1dbc1_0

libtiff                   4.0.10               hb898794_2

libxml2                   2.9.9                h464c3ec_0

libxslt                   1.1.33               h579f668_0

llvmlite                  0.29.0           py37ha925a31_0

locket                    0.2.0                    py37_1

lxml                      4.4.1            py37h1350720_0

lz4-c                     1.8.1.2              h2fa13f4_0

lzo                       2.10                 h6df0209_2

m2w64-gcc-libgfortran     5.3.0                         6

m2w64-gcc-libs            5.3.0                         7

m2w64-gcc-libs-core       5.3.0                         7

m2w64-gmp                 6.1.0                         2

m2w64-libwinpthread-git   5.0.0.4634.697f757               2

markupsafe                1.1.1            py37he774522_0

matplotlib                3.1.1            py37hc8f65d3_0

mccabe                    0.6.1                    py37_1

menuinst                  1.4.16           py37he774522_0

mistune                   0.8.4            py37he774522_0

mkl                       2019.4                      245

mkl-service               2.3.0            py37hb782905_0

mkl_fft                   1.0.14           py37h14836fe_0

mkl_random                1.1.0            py37h675688f_0

mock                      3.0.5                    py37_0

more-itertools            7.2.0                    py37_0

mpmath                    1.1.0                    py37_0

msgpack-python            0.6.1            py37h74a9793_1

msys2-conda-epoch         20160418                      1

multipledispatch          0.6.0                    py37_0

navigator-updater         0.2.1                    py37_0

nbconvert                 5.6.0                    py37_1

nbformat                  4.4.0                    py37_0

networkx                  2.3                        py_0

nltk                      3.4.5                    py37_0

nose                      1.3.7                    py37_2

notebook                  6.0.1                    py37_0

numba                     0.45.1           py37hf9181ef_0

numexpr                   2.7.0            py37hdce8814_0

numpy                     1.16.5           py37h19fb1c0_0
numpy-base                1.16.5           py37hc3f5095_0

numpydoc                  0.9.1                      py_0

olefile                   0.46                     py37_0

openpyxl                  3.0.0                      py_0

openssl                   1.1.1d               he774522_2

packaging                 19.2                       py_0

pandas                    0.25.1           py37ha925a31_0
pandoc                    2.2.3.2                       0

pandocfilters             1.4.2                    py37_1

parso                     0.5.1                      py_0

partd                     1.0.0                      py_0

path.py                   12.0.1                     py_0

pathlib2                  2.3.5                    py37_0

patsy                     0.5.1                    py37_0

pep8                      1.7.1                    py37_0

pep8-naming               0.10.0                   pypi_0    pypi

pickleshare               0.7.5                    py37_0

pillow                    6.2.0            py37hdc69c19_0

pip                       19.2.3                   py37_0

pkginfo                   1.5.0.1                  py37_0

plotly                    5.7.0                    pypi_0    pypi

pluggy                    0.13.0                   py37_0

ply                       3.11                     py37_0

powershell_shortcut       0.0.1                         2

prometheus_client         0.7.1                      py_0

prompt_toolkit            2.0.10                     py_0

prospector                1.3.1                    pypi_0    pypi

psutil                    5.6.3            py37he774522_0

py                        1.8.0                    py37_0
py-lief                   0.9.0            py37ha925a31_2

pycodestyle               2.6.0                    pypi_0    pypi

pycosat                   0.6.3            py37hfa6e2cd_0

pycparser                 2.19                     py37_0

pycrypto                  2.6.1            py37hfa6e2cd_9

pycurl                    7.43.0.3         py37h7a1dbc1_0

pydocstyle                6.1.1                    pypi_0    pypi

pyflakes                  2.2.0                    pypi_0    pypi

pygments                  2.4.2                      py_0

pylint                    2.5.3                    pypi_0    pypi

pylint-celery             0.3                      pypi_0    pypi

pylint-django             2.1.0                    pypi_0    pypi

pylint-flask              0.6                      pypi_0    pypi

pylint-plugin-utils       0.6                      pypi_0    pypi

pyodbc                    4.0.27           py37ha925a31_0

pyopenssl                 19.0.0                   py37_0

pyparsing                 2.4.2                      py_0

pyqt                      5.9.2            py37h6538335_2

pyreadline                2.1                      py37_1

pyrsistent                0.15.4           py37he774522_0

pysocks                   1.7.1                    py37_0

pytables                  3.5.2            py37h1da0976_1

pytest                    5.2.1                    py37_0
pytest-arraydiff          0.3              py37h39e3cac_0

pytest-astropy            0.5.0                    py37_0

pytest-doctestplus        0.4.0                      py_0

pytest-openfiles          0.4.0                      py_0

pytest-remotedata         0.3.2                    py37_0

python                    3.7.4                h5263a28_0
python-dateutil           2.8.0                    py37_0

python-libarchive-c       2.8                     py37_13

pytz                      2019.3                     py_0

pywavelets                1.0.3            py37h8c2d366_1

pywin32                   223              py37hfa6e2cd_1

pywinpty                  0.5.5                 py37_1000

pyyaml                    5.1.2            py37he774522_0

pyzmq                     18.1.0           py37ha925a31_0

qt                        5.9.7            vc14h73c81de_0

qtawesome                 0.6.0                      py_0

qtconsole                 4.5.5                      py_0

qtpy                      1.9.0                      py_0

requests                  2.22.0                   py37_0

requirements-detector     0.7                      pypi_0    pypi

rope                      0.14.0                     py_0

ruamel_yaml               0.15.46          py37hfa6e2cd_0

scikit-image              0.15.0           py37ha925a31_0

scikit-learn              0.21.3           py37h6288b17_0

scipy                     1.3.1            py37h29ff71c_0

seaborn                   0.9.0                    py37_0

send2trash                1.5.0                    py37_0

setoptconf                0.2.0                    pypi_0    pypi

setuptools                41.4.0                   py37_0

simplegeneric             0.8.1                    py37_2

singledispatch            3.4.0.3                  py37_0

sip                       4.19.8           py37h6538335_0

six                       1.12.0                   py37_0

snappy                    1.1.7                h777316e_3

snowballstemmer           2.0.0                      py_0

sortedcollections         1.1.2                    py37_0

sortedcontainers          2.1.0                    py37_0

soupsieve                 1.9.3                    py37_0

sphinx                    2.2.0                      py_0

sphinxcontrib             1.0                      py37_1

sphinxcontrib-applehelp   1.0.1                      py_0

sphinxcontrib-devhelp     1.0.1                      py_0

sphinxcontrib-htmlhelp    1.0.2                      py_0

sphinxcontrib-jsmath      1.0.1                      py_0

sphinxcontrib-qthelp      1.0.2                      py_0

sphinxcontrib-serializinghtml 1.1.3                      py_0

sphinxcontrib-websupport  1.1.2                      py_0

spyder                    3.3.6                    py37_0

spyder-kernels            0.5.2                    py37_0

sqlalchemy                1.3.9            py37he774522_0

sqlite                    3.30.0               he774522_0

statsmodels               0.10.1           py37h8c2d366_0

sympy                     1.4                      py37_0

tbb                       2019.4               h74a9793_0

tblib                     1.4.0                      py_0

tenacity                  8.0.1                    pypi_0    pypi

terminado                 0.8.2                    py37_0

testpath                  0.4.2                    py37_0

tk                        8.6.8                hfa6e2cd_0

toml                      0.10.2                   pypi_0    pypi

toolz                     0.10.0                     py_0

tornado                   6.0.3            py37he774522_0

tqdm                      4.36.1                     py_0

traitlets                 4.3.3                    py37_0

typed-ast                 1.4.3                    pypi_0    pypi

unicodecsv                0.14.1                   py37_0

urllib3                   1.24.2                   py37_0

vboxapi                   1.0                      pypi_0    pypi

vc                        14.1                 h0510ff6_4

vs2015_runtime            14.16.27012          hf0eaf9b_0

wcwidth                   0.1.7                    py37_0

webencodings              0.5.1                    py37_1

werkzeug                  0.16.0                     py_0

wheel                     0.33.6                   py37_0

widgetsnbextension        3.5.1                    py37_0

win_inet_pton             1.1.0                    py37_0

win_unicode_console       0.5                      py37_0

wincertstore              0.2                      py37_0

winpty                    0.4.3                         4

wrapt                     1.11.2           py37he774522_0

xlrd                      1.2.0                    py37_0

xlsxwriter                1.2.1                      py_0

xlwings                   0.15.10                  py37_0

xlwt                      1.3.0                    py37_0

xmltodict                 0.12.0                     py_0

xz                        5.2.4                h2fa13f4_4

yaml                      0.1.7                hc54c509_2

zeromq                    4.3.1                h33f27b4_3

zict                      1.0.0                      py_0

zipp                      0.6.0                      py_0

zlib                      1.2.11               h62dcd97_3

zstd                      1.3.7                h508b16e_0

(base) PS C:\Users\jozefg>

(base) PS C:\Users\jozefg> conda install matplotlib
Collecting package metadata (current_repodata.json): done

Solving environment: done

## Package Plan ##

  environment location: C:\ProgramData\Anaconda3

  added / updated specs:

    - matplotlib
The following packages will be downloaded:

    package                    |            build

    ---------------------------|-----------------

    conda-4.12.0               |   py37haa95532_0        14.4 MB

    ------------------------------------------------------------

                                           Total:        14.4 MB

The following packages will be UPDATED:

  conda                               4.10.3-py37haa95532_0 --> 4.12.0-py37haa95532_0

Proceed ([y]/n)? y

Downloading and Extracting Packages

conda-4.12.0         | 14.4 MB   | ############################################################################ | 100%

Preparing transaction: done

Verifying transaction: failed

EnvironmentNotWritableError: The current user does not have write permissions to the target environment.

  environment location: C:\ProgramData\Anaconda3

(base) PS C:\Users\jozefg> conda install chart_studio
Collecting package metadata (current_repodata.json): done

Solving environment: failed with initial frozen solve. Retrying with flexible solve.

Collecting package metadata (repodata.json): done

Solving environment: failed with initial frozen solve. Retrying with flexible solve.

PackagesNotFoundError: The following packages are not available from current channels:

  - chart_studio
Current channels:

  - https://repo.anaconda.com/pkgs/main/win-64

  - https://repo.anaconda.com/pkgs/main/noarch

  - https://repo.anaconda.com/pkgs/r/win-64

  - https://repo.anaconda.com/pkgs/r/noarch

  - https://repo.anaconda.com/pkgs/msys2/win-64

  - https://repo.anaconda.com/pkgs/msys2/noarch

To search for alternate channels that may provide the conda package you're

looking for, navigate to

    https://anaconda.org

and use the search bar at the top of the page.

(base) PS C:\Users\jozefg> conda install plotly
Collecting package metadata (current_repodata.json): done

Solving environment: done

## Package Plan ##

  environment location: C:\ProgramData\Anaconda3

  added / updated specs:

    - plotly

The following packages will be downloaded:

    package                    |            build

    ---------------------------|-----------------

    plotly-3.6.1               |           py37_0        12.9 MB

    retrying-1.3.3             |           py37_2          16 KB

    ------------------------------------------------------------

                                           Total:        12.9 MB

The following NEW packages will be INSTALLED:

  plotly             pkgs/main/win-64::plotly-3.6.1-py37_0

  retrying           pkgs/main/win-64::retrying-1.3.3-py37_2

The following packages will be UPDATED:

  conda                               4.10.3-py37haa95532_0 --> 4.12.0-py37haa95532_0

Proceed ([y]/n)? y

Downloading and Extracting Packages

plotly-3.6.1         | 12.9 MB   | ############################################################################ | 100%

retrying-1.3.3       | 16 KB     | ############################################################################ | 100%

Preparing transaction: done

Verifying transaction: failed

EnvironmentNotWritableError: The current user does not have write permissions to the target environment.

  environment location: C:\ProgramData\Anaconda3

(base) PS C:\Users\jozefg> conda install sklearn
Collecting package metadata (current_repodata.json): done

Solving environment: failed with initial frozen solve. Retrying with flexible solve.

Collecting package metadata (repodata.json): done

Solving environment: failed with initial frozen solve. Retrying with flexible solve.

PackagesNotFoundError: The following packages are not available from current channels:

  - sklearn

Current channels:

  - https://repo.anaconda.com/pkgs/main/win-64

  - https://repo.anaconda.com/pkgs/main/noarch

  - https://repo.anaconda.com/pkgs/r/win-64

  - https://repo.anaconda.com/pkgs/r/noarch

  - https://repo.anaconda.com/pkgs/msys2/win-64

  - https://repo.anaconda.com/pkgs/msys2/noarch

To search for alternate channels that may provide the conda package you're

looking for, navigate to

    https://anaconda.org

and use the search bar at the top of the page.
	
	


The variance is one of the measures of dispersion, that is a measure of by how much the values in the data set are likely to differ from the mean of the values. It is the average of the squares of the deviations from the mean. Squaring the deviations ensures that negative and positive deviations do not cancel each other out.
Population Variance:
The formula for the variance of an entire population is:

[image: image17.png]




where N is the population size and μ is the population mean.

This calculator uses the following formulas for calculating the variance:

Sample Variance:
The formula for the variance of a sample is:

[image: image18.png]




where n is the sample size and x-bar is the sample mean.
Standard deviation: p.186 - a measure of the difference between a value and the mean. 
· A large standard deviation indicates values are dispersed, whereas a small standard deviation indicates that the values are closely grouped.
Population Standard Deviation Equation
There are different ways to write out the steps of the population standard deviation calculation into an equation. A common equation is:

σ = ( [ Σ (x - u)2 ] /N )1/2
Where:

· σ is the population standard deviation

· Σ represents the sum or total from 1 to N

· x is an individual value

· u is the average of the population

· N is the total number of the population

Sample Standard Deviation Equation
There are different ways to write out the steps of the population standard deviation calculation into an equation. A common equation is:

σ = ( [Σ(x - u)2] / (N – 1) )1/2
Where:

· σ is the population standard deviation

· Σ represents the sum or total from 1 to N

· x is an individual value

Use  ( [ Σ (x - u)2 ] to calculate ones as  a procedure and use to calculate other formulas.

Geometric mean: p.180 - is the average of a set of products, it is technically defined as "the nth root product of n numbers." 
· The calculation of which is commonly used to determine the performance results of an investment or portfolio. 
· The geometric mean must be used when working with percentages (e.g. compounding interest), which are derived from values, while the standard arithmetic mean works with the values themselves.
Weighted harmonic mean of x1, x2, x3 with the corresponding weights w1, w2, w3 is given as:
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Harmonic mean: p.180 – (a type of numerical average) the harmonic mean is the weighted harmonic mean, where the weights are equal to 1.
· Or the number of cases divided by the reciprocal of each number in the series.  It is the reciprocal of the arithmetic mean of the reciprocals. The harmonic mean may reduce the impact of outliers. https://www.investopedia.com/terms/h/harmonicaverage.asp. 
Examples:
In the UML class diagram each class is modeled as a rectangle (or an oval) with three compartments as follows:

If you have more than one class you should show the relationship graphically (see Diagram_Pseudocode_Examples.doc).

The textbook ed.6 example => p.132 for Fig 4.11
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Console.WriteLine( 

“Please enter a 

positive number of 

rows: “);

Rows = 

Convert.ToInt32(Co

nsole.Readline());

Rows < 0;

Rows = 

Convert.ToInt32(Co

nsole.Readline());

true

Console.WriteLine( 

“Please enter a 

positive number of 

columns: “);

Rows = 

Convert.ToInt32(Co

nsole.Readline());

Cols  < 0;

Cols  = 

Convert.ToInt32(Co

nsole.Readline());

true

false

counter = 1

false

counter <= 

Cols

header += “   “; dashes += “---“; true counter++

row = 0

row < Rows true

false

col  = 0

col < Cols

a[row, col] = 

Convert.ToInt32 

(Console.ReadLine())

true col++

Console.WriteLine 

(“Please enter any 

integer: “);

rowSums[row] 

+= a[row, col]

colSums[col] 

+= a[row, col]

sum += 

a[row, col]

rowr++

false

Console.Write (“{0}    

| Sum:\n    {1}\n“, 

header, dashes);

false

ror = 0

row < Rows true

col = 0

col < Cols true col++

Console.Write 

(“{0:D2}  “, a[row, 

col]);

row++

false

Console.Write (“{0}    

| Sum:\n    {1}\n“, 

header, dashes);

false

Console.Write (“ |  

{0:D2 \n}”, 

rowSums[row]);

Console.Write (“     

{0}\nSum: “, dashes);

Start

element in 

colSums

Console.WriteLine 

(“{0:D2 }”, element);

true

End

false

Console.WriteLine 

(“| {0:D2} = Sum 

Total\n“, sum);

catch 

(Exception e)

false

Console.WriteLine 

(“\n” + e.Message + 

“\n”);

true


Example of a flowchart of method Play():


[image: image22.emf]Start

End

Initialize gameStatus, 

myPoint, and sumOfDice

Console.WriteLine(“Wins\t 

%Wins\t\tLosses\t%Losses\n 

{0}\t{1:F2}\t\t {2}\t{3:F2}”, 

numWins, percentWins, 

numLosses, percentLosses);

int counter = 1

counter <= plays

Console.WriteLine(“Game 

Number: {0}”, counter);

sumOfDice = RollDice();

case: SEVEN,

YO_LEVEN

case: SNAKE_EYES, 

TREY, BOX_CARS

gameStatus = Status.CONTINUE;

myPoint = sumOfDice;

break;

gameStatus = 

Status.WON

break;

break;

true

false

false

true

true

gameStatus == 

Status.CONTINUE

false

sumOfDice = RollDice(); true

sumOfDice = myPoint

gameStatus = 

Status.LOST

gameStatus = 

Status.WON

sumOfDice = (int) 

DiceNames.SEVEN

true

false

gameStatus = 

Status.LOST

true

false

gameStatus == 

Status.WON

false

Console.WriteLine( 

“  Player wins!\n”);

true numWins++;

Console.WriteLine( 

“  Player loses!\n”);

numLosses++; false

myPoint = 0;

gameStatus = 

Status.CONTINUE

int counter = 2

counter < 

rollSums.Length

counter++;

counter++;

Console.WriteLine( 

“Frequency of dice rolls:\n 

Sum\tFrequency”);

Console.WriteLine( “  Point is 

{0}”, myPoint);

Console.WriteLine( 

“{0}\t{1}”, counter, 

rollSums[counter]);

true

false

Console.WriteLine(“Average

number of rolls per game: 

{0:F2}”, (decimal) 

numRolls / plays);

percentWins = ((decimal) 

numWins / plays) * 100;

percentWins = ((decimal) 

numWins / plays) * 100;

Play()


L9: Download and install

MongoDB at https://www.mongodb.com/. Follow all instructions to register and create a Shared Cluster. To get your IP – go the browser and type “my IP”. Finally, click 

“Create” on Database Deployments web page then click Connect.

Select “Connect with the Mongo Shell”.

Select “Connect using MongoDB Compass”.

Download Compass.

Copy the connection string, then open MongoDB Compass.

     mongodb+srv://<login>:<password>@cluster0.wj8ur.mongodb.net/test

	mongodb+srv://j122256g:<password>@cluster0.wj8ur.mongodb.net/test


mongodb+srv://j122256g:<password>@cluster0.wj8ur.mongodb.net/test
a. Selecting Operating System and click on “Download mongosh (5.3.1). Unzip it. Follow instructons.
b. Add <your mongosh's download directory>/bin to your $PATH variable. 
c. Run your connection string in your command line
Use this connection string in your application:

	mongosh "mongodb+srv://cluster0.wj8ur.mongodb.net/myFirstDatabase" --apiVersion 1 -- jgoetz@laverne.edu


Replace myFirstDatabase with the name of the database that connections will use by default. You will be prompted for the password for the Database User, j122256g. When entering your password, make sure all special characters are URL encoded.

Shell:
mongosh "mongodb+srv://cluster0.wj8ur.mongodb.net/MyBusiness" --apiVersion 1 --username jgoetz@laverne.edu
GUI:
FROM: https://medium.com/swlh/get-up-and-running-with-mongodb-in-under-5-minutes-abc8770b1ef8 
Class name: GradeBook





list of variable declarations and properties


count : int = 500


+ <property> CourseName : String





list of methods:


+ <constructor> GradeBook ( name :  string)


+ DisplayMessage()


-  Helper()


+ IsStudentPassed( name: string) : bool
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Main


Console.WriteLine( “Please enter a positive number of rows: “);


Rows = Convert.ToInt32(Console.Readline());


Rows < 0;


Rows = Convert.ToInt32(Console.Readline());


true


Console.WriteLine( “Please enter a positive number of columns: “);


Rows = Convert.ToInt32(Console.Readline());


Cols  < 0;


Cols  = Convert.ToInt32(Console.Readline());


true


false


counter = 1


false


counter <= Cols


header += “   “;


dashes += “---“;


true


counter++


row = 0


row < Rows


col  = 0


col < Cols


true


Console.WriteLine (“Please enter any integer: “);


a[row, col] = Convert.ToInt32 (Console.ReadLine())


true


false


col++


rowSums[row] += a[row, col]


�

colSums[col] += a[row, col]


�

sum += a[row, col]


�

rowr++


false


Console.Write (“{0}    | Sum:\n    {1}\n“, header, dashes);


false


ror = 0


row < Rows


true


col = 0


col < Cols


Console.Write (“ |  {0:D2 \n}”, rowSums[row]);


true


col++


Console.Write (“{0:D2}  “, a[row, col]);


Console.Write (“     {0}\nSum: “, dashes);


Start


element in colSums


Console.WriteLine (“{0:D2 }”, element);


true


row++


false


Console.Write (“{0}    | Sum:\n    {1}\n“, header, dashes);


false


End


false


Console.WriteLine (“| {0:D2} = Sum Total\n“, sum);


catch (Exception e)


false


Console.WriteLine (“\n” + e.Message + “\n”);


true
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Play()


Start


int counter = 1


counter <= plays


Initialize gameStatus, myPoint, and sumOfDice


End


Console.WriteLine(“Game Number: {0}”, counter);


sumOfDice = RollDice();


case: SEVEN,
YO_LEVEN


case: SNAKE_EYES, TREY, BOX_CARS


gameStatus = Status.CONTINUE;
myPoint = sumOfDice;


break;


gameStatus = Status.WON


gameStatus = Status.WON


break;


break;


true


false


false


true


true


Console.WriteLine(“Wins\t %Wins\t\tLosses\t%Losses\n {0}\t{1:F2}\t\t {2}\t{3:F2}”, numWins, percentWins, numLosses, percentLosses);


gameStatus == Status.CONTINUE


Console.WriteLine( “Frequency of dice rolls:\n Sum\tFrequency”);


false


sumOfDice = RollDice();


true


sumOfDice = myPoint


gameStatus = Status.LOST


sumOfDice = (int) DiceNames.SEVEN


true


false


gameStatus = Status.LOST


true


false


gameStatus == Status.WON


false


Console.WriteLine( “  Player wins!\n”);


true


numWins++;


Console.WriteLine( “  Player loses!\n”);


numLosses++;


false


myPoint = 0;


gameStatus = Status.CONTINUE


int counter = 2


counter < rollSums.Length


counter++;


counter++;


Console.WriteLine( “  Point is {0}”, myPoint);


Console.WriteLine( “{0}\t{1}”, counter, rollSums[counter]);


true


false


Console.WriteLine(“Averagenumber of rolls per game: {0:F2}”, (decimal) numRolls / plays);


percentWins = ((decimal) numWins / plays) * 100;


percentWins = ((decimal) numWins / plays) * 100;



